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11.1. Diseño asistido por computadora de dispositivos 
electrónicos 
 

El diseño asistido por computadora CAD se establece en muchas áreas 
industriales. El diseño CAD significa que utilizamos herramientas de tecnologías de la 
información TI en el proceso de diseño. El diseño CAD consta de hardware, software 
específico y dispositivos externos, e interfaces. El núcleo del diseño CAD es un paquete 
de programas que utiliza gráficos para la pantalla, diferentes bases de datos y 
controladores para dispositivos periféricos. El diseño CAD no cambia el proceso de 
diseño, pero lo facilita y lo acelera significativamente. Estas herramientas son muy 
eficientes, especialmente en el diseño de dispositivos que deben ser ecológicamente 
eficientes. Muchas herramientas ya contienen equipos que ayudan a analizar y evaluar 
si el diseño es ecológico. Algunas herramientas también contienen contenedores de 
datos con elementos y materiales que forman parte del diseño. La esencia del diseño 
CAD se resume en los siguientes puntos: 

• Presentación gráfica precisa del producto. También es más fácil analizarlo, 
modificarlo o actualizarlo. 

• Permite un diseño complejo en muy poco tiempo. 

• Permite la simulación de diferentes eventos, como eléctrico, químico, 
térmico y mecánico. 

• Con las herramientas de simulación, es más fácil proporcionar un enfoque 
óptimo para el diseño y el producto en sí. 

Las primeras herramientas CAD se desarrollaron para la industria espacial y 
automotriz. Últimamente, las herramientas CAD se han expandido a otras áreas de 
ingeniería, como la industria electrónica y textil, el embalaje, etc. 

Las herramientas CAD se han diseñado originalmente para la automatización de 
procesos de diseño y modelado de sistemas. Las herramientas CAD modernas son 
compatibles con la mayoría de las actividades en la fase de diseño. Contienen 
información sobre las características del producto y los materiales usados. Estas 
herramientas también sirven como una plataforma común para el intercambio de datos 
entre diferentes grupos de diseño y equipos. Pueden contener información sobre 
producción y a menudo se denominan herramientas CAD / CAM (fabricación asistida por 
computadora). La Imagen 1 presenta el proceso de diseño ordinario y CAM / CAD. La 
herramienta CAD acorta el tiempo de diseño, lo que significa que el producto estará en 
el mercado antes y el desarrollo del producto será más económico. Las herramientas 
CAD también ahorran procesos de diseño, lo que permite una actualización más rápida 
y fácil de la versión inicial. La Imagen 2 presenta el tiempo promedio dedicado al diseño 
del producto y su uso. Cuanto menor es el tiempo de diseño, mayor es la utilidad del 
dispositivo en el mercado. Esta condición solo es válida si el diseño se realiza 
correctamente. 
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IMAGEN 1: EJEMPLO DE DISEÑO CLÁSICO Y CAD/CAM. 

 

 

IMAGEN 2: TIEMPO MEDIO DE DISEÑO Y DE USO DE PRODUCTO. 

 

En el siguiente capítulo, presentaremos las herramientas de CAD que están destinadas 
al diseño de dispositivos electrónicos. 
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11.2.  Diseño de placas de circuito impreso 
 

El diseño de tarjetas de circuitos impresos PCB es la tarea clave de cada proceso 
de desarrollo. Un circuito bien diseñado y la materia impresa en sí misma influyen en la 
calidad y la fiabilidad del dispositivo. Con el proceso de diseño, determinamos todos los 
elementos y el tamaño del circuito. Al elegir los componentes y el tamaño de la materia 
impresa, podemos cumplir con muchas pautas ecológicas. Por lo general, utilizamos 
componentes que son más pequeños, consumen menos energía y los circuitos de diseño 
requieren menos espacio. Hoy conocemos muchas tecnologías avanzadas que permiten 
la impresión de múltiples capas. Estos permiten una superficie de circuito más pequeña 
y, en consecuencia, un menor consumo de material. Por otro lado, necesitamos saber 
que la tecnología de producción es mucho más costosa y usa más energía, que es menos 
ecológica. Al diseñar material impreso, debemos encontrar un compromiso entre los 
elementos elegidos y el tamaño de la materia impresa para que tenga un menor impacto 
ecológico en la fase de producción. Además de estos aspectos, debemos considerar 
ciertas pautas y regulaciones sobre el diseño de la materia impresa con la intención de 
lograr una alta confiabilidad y calidad de la materia impresa y el dispositivo final. 

Los estándares para el diseño de material impreso son monitoreados por 
asociación ICP. Gestionan la estandarización de la producción de material impreso y el 
uso de materiales. El documento principal que cubre el diseño de tarjetas de circuitos 
impresos es el documento ICP-2221 - Norma genérica sobre diseño de placas de circuitos 
impresos. 

Los pasos estándar en el diseño de la materia impresa son: 

• Especificación del proyecto. 

• Diseño de esquema eléctrico. 

• Diseño de circuito. 

• Prototipos. 

• Prueba. 

• Producción. 

Actualmente, hay muchas herramientas en el mercado que permiten el diseño de 
circuitos impresos. Estos son algunos de los más utilizados: 

• AutoTRAX (Esquema, diseño PCB with simulador built-in Spice) 

• Sistema de Diseño Avanzado / Advanced Design System (Destinado a la 
electrónica de RF: teléfonos móviles, red WiFi, comunicación por satélite, 
radares, circuito de FV, simuladores de FV)  

• Eagle (Esquema, diseño PCB, disponible versión gratuita para Proyectos 
pequeños, ambiente académico, vista 3D, etc.).  

• Diseñador Altium (para Protel, esquemas, PCB, apoyo para FPGA – Field 
Programmable gate array, con opción de programado, traducción de 
código de programa, vista 3D)  
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• Herramientas OrCAD (Esquemas, PCB)  

• CADSTAR (Esquema, diagramas, PCB, versión gratuita disponible con 
funciones básicas, CADSTAR Express)  

• KICAD (ambiente de Código abierto, esquema, PCB and vista 3D) 

11.2.1 Diseño de esquemas electrónicos 

 

Al diseñar esquemas electrónicos, es importante que el esquema esté 
organizado, que las relaciones sean lógicas y que haya el menor cruce posible. Un buen 
esquema también está diseñado de una manera que es muy similar al material impreso 
final. Por ejemplo, si queremos colocar un condensador cerca de un determinado 
componente electrónico, también lo dibujamos cerca del símbolo o componente en el 
esquema. Nos atenemos a la regla no escrita de que todas las entradas están a la 
izquierda y todas las salidas a la derecha del esquema. Si es necesario, también usamos 
comentarios y notas. En circuitos complejos, definimos áreas de esquema para una 
mejor visibilidad. Todas las áreas juntas crean el esquema completo del dispositivo. Las 
áreas son solo secciones de esquemas virtuales que completan las partes de los 
circuitos. Por ejemplo, dibujamos la parte de la fuente de alimentación por separado o 
en un área determinada del esquema. La parte de control también está diseñada en su 
propia área, etc. La imagen 3 presenta el esquema clásico para el diseño de la placa de 
circuito impreso. 

 

IMAGEN 3: ESQUEMA PARA EL DISEÑO DE UN TABLERO DE CIRCUITO IMPRESO. 

 

11.2.2 Diseño de material impreso 
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Igualmente importante es hacer el plan para el próximo paso en la producción de 
material impreso. Diseñar la materia impresa consiste en la disposición del elemento y 
las conexiones entre ellos. Con la producción de material impreso, determinamos la 
apariencia final de la materia impresa. En la producción, es muy importante que usemos 
bibliotecas de elementos. En estos, podemos encontrar las características y dimensiones 
del elemento, así como los nombres de las abrazaderas conectadas. En la producción de 
material impreso, debemos considerar las siguientes reglas: 

• Elección de material impreso (material, ancho). 

• Cantidad de capas de material impreso. 

• Disposición de capas. 

• Disposición del circuito en material impreso. 

• Consideración de impactos parasitarios. 

• El diseño del componente en la materia impresa. 
 

 

IMAGEN 4: MATERIA IMPRESA - PCB. 

 

En la producción de material impreso, a menudo encontramos diferentes 
sistemas métricos. Los componentes electrónicos generalmente tienen dimensiones y 
disposición de patas de conexión presentadas en unidades de pulgadas. En Europa, las 
unidades métricas se usan con mayor frecuencia. La unidad de pulgadas se utiliza con 
mayor frecuencia para las dimensiones de las conexiones, los conectores de cobre y las 
almohadillas. Las unidades métricas se utilizan para determinar la dimensión del orificio, 
el tamaño de la materia impresa y las dimensiones de la carcasa del circuito. 

Líneas de cobre 

El grosor de la línea de cobre se elige según los requisitos eléctricos y el espacio 
en la materia impresa. Las líneas más gruesas dan respuestas más rápidas y mejores 
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resultados. Las líneas más anchas y gruesas tienen una menor resistencia y una longitud 
más corta, su producción es más fácil y más barata, son más fáciles de reparar y 
examinar. Al elegir el fabricante de la materia impresa, necesitamos saber cuáles son 
algunas de las líneas más cercanas y las separaciones más pequeñas que el fabricante 
puede proporcionar. 

Por ejemplo, ofrecer 10/8 significa que las líneas pueden tener al menos 10 mil 
de ancho y la distancia entre ellas puede ser de al menos 8 mil. Las ofertas típicas son 
10/10 u 8/8. Generalmente, casi todos los fabricantes pueden producir material impreso 
con 12/12. El estándar IPC recomienda el límite más bajo hasta 4/4. Distancias más 
pequeñas pueden significar que los costos de producción de material impreso son 
significativamente mayores. Un ejemplo de buenas prácticas de uso de una línea más 
ancha y su estrechamiento en los lugares donde es necesario se presenta en la imagen 
5. De esta manera, podemos retener la impedancia total más baja. 

 

IMAGEN 5: EJEMPLO DE ESTRECHAMIENTO DE LÍNEA . 

El ancho y la longitud del cable están determinados por la corriente eléctrica y la 
frecuencia de la señal eléctrica. Para corrientes más altas, se recomienda que usemos 
líneas tan gruesas como sea posible. Las líneas más estrechas tienen mayor resistencia, 
lo que provoca pérdidas y calentamiento no deseado del conductor. La Tabla 1 a 
continuación presenta el ancho de línea recomendado en función de la corriente con un 
aumento de temperatura de 10˚C. 

 Ancho de línea preferido (mil) 1mil=0.0254mm 
Corriente [A] 1oz  Ancho (µm) 2oz Ancho (µm) 

1 350 175 
2 1050 525 
3 1750 875 
4 2800 1400 
5 3850 1925 
6 5250 2625 
7 6300 3150 
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8 7700 3850 
9 9100 4550 

10 10500 5250 

TABLA 1: ANCHO DE LÍNEA DE COBRE EN MATERIA IMPRESA CON CORRIENTE. 

La resistencia del alambre de cobre se calcula con la fórmula:  

𝑅 =
𝜌𝐶𝑢𝑙

𝑆
,   𝜌𝐶𝑢 = 1.724 × 10−6Ω𝑐𝑚, 

Donde 𝑅  es resistencia,  𝑙  longitud, 𝑆  sección transversal y 𝜌𝐶𝑢  la resistividad 
específica del cobre. La longitud de línea está condicionada por la frecuencia de señal 
anticipada. Un ejemplo de buena práctica da una estimación de la longitud de línea 
dependiendo de la frecuencia de la señal: 

𝐿 =
1

20
𝜆 =

1𝑐

20𝜐
 , 

donde 𝐿  es la longitud de línea permitida, 𝜆 es longitud de onda, 𝜐 es frecuencia 
de onda y 𝑐 es la velocidad de la luz. En señales de alta frecuencia, la condición no se 
puede cumplir, por lo que es necesario considerar el tiempo de propagación de la señal 
en la línea dada, lo que provoca un retraso de tiempo. En conductores paralelos, es 
importante que sean más cortos e iguales en longitud. La mayoría de los paquetes de 
programas corrigen longitudes de conductores críticos. En las líneas de alta frecuencia, 
también evitamos los conectores de RF, que causan disturbios y pérdida de señal. 

Acceso de interconexión vertical 

Los VIA son líneas de cobre metalizadas con diferentes capas. Son muy similares a 
las almohadillas de conexión con las que no debemos confundirlas. La plataforma de 
conexión es parte del conector del componente, y VIA solo conecta las conexiones entre 
diferentes capas de material impreso. La Imagen 6 presenta VIA en material impreso 

multicapa.  

IMAGE 6: VIA EN MATERIA IMPRESA MULTICAPA. 

Polígonos 

Los polígonos se utilizan para rellenar áreas más grandes con cobre puro o textura 
de cobre, como se ve en la imagen 7. Los polígonos están interconectados por 
almohadillas de conexión y VIAs. Por lo general, se utilizan para sustituir las superficies 
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de suministro de energía y conexión a tierra. Los instalamos al final después de que 
todas las otras líneas de cobre ya están trazadas. 

 

 

a) b) 

 

 

IMAGEN 7:POLIGONO DE MATERIA IMPRESA; A) CAPA SUPERIOR, B) TEXTURA DE COBRE. 

 

Al trazar los polígonos y las líneas, debemos considerar el espacio vacío entre 
líneas o polígonos. Las distancias demasiado pequeñas no son buenas porque pueden 
causar cortos circuitos que pueden ocurrir en la fase de producción. También debemos 
considerar el límite inferior para producir material impreso. Depende del fabricante y la 
tecnología de producción. La regla común es 15 mil para los componentes de alambre y 
8 a 10 mil como el límite inferior para los elementos que se montan en la superficie. Para 
los circuitos que funcionan a una tensión de red de 230 V / 110 V, debemos considerar 
estándares de seguridad que sean válidos para un área geográfica determinada. La regla 
básica es que entre la fase y la corriente cero tiene que ser al menos 3.2.mm de 
distancia. La distancia más pequeña entre las partes de alta tensión y las partes con las 
que el usuario puede entrar en contacto es de 8 mm. ¡Una guía simple es que las 
distancias deben ser mejor grandes que pequeñas cuando están dentro de las 
dimensiones límites! 

En las dimensiones también debemos considerar el aislamiento galvánico. Estas 
distancias están definidas por el estándar IPC. Las distancias difieren según estén dentro 
o fuera de la materia impresa y el área donde se usará el componente electrónico 
(ambiente húmedo, altitud, etc.). A menudo protegemos la materia impresa con un 
recubrimiento de laca que aumenta la resistencia galvánica a la corrosión y protege el 
circuito de los efectos externos. La Tabla 2 presenta distancias y capas estándar para 
diferentes componentes de un circuito impreso por voltaje. El aislamiento galvánico se 
determina por voltaje de ruptura. La resistencia a la ruptura es una característica 
material que viene dada por la siguiente fórmula: 

𝐸𝑝 =
𝑈𝑝

𝑑
    [

𝑉

𝑚
], 
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donde 𝐸𝑝  es fuerza de ruptura eléctrica, 𝑈𝑝 es el voltaje eléctrico y 𝑑  es una 

dimensión aislante. Diferentes aislantes tienen distintas fuerzas de ruptura eléctrica 
como se presenta en la tabla 3.  

 

Voltaje Capas internas Conductores externos 
sin recubrimiento 

Conductores 
externos con 

recubrimiento 
[V] [mm] [mm] [mm] 

15 0.05 0.1 0.05 
20 0.05 0.1 0.05 
50 0.1 0.6 0.13 

100 0.1 0.6 0.13 
150 0.2 0.6 0.4 
170 0.2 1.25 0.4 
250 0.2 1.25 0.4 
300 0.2 1.25 0.4 
500 0.25 2.5 0.8 

1000 1.5 5 2.33 
4000 9 20 11.48 
5000 11.5 25 11.53 

TABLA 2: DISTANCIAS PRESCRITAS PARA AISLAMIENTO GALVÁNICO DE LÍNEAS DE MATERIA IMPRESAS. 

 

Aislante (20C̊) 
𝐸𝑝  [

𝑉

𝑚
] × 106 

Aire 3 
Papel 10 
Goma 10 

Aceite transformado 15 
Porcelana 20 

Polyvinyl Chloride-PVC 50 
Polystyrol 80 

TABLA 3: FUERZA DE RUPTURA ELÉCTRICA DE ALGUNOS MATERIALES. 

 

Reglas básicas para conectar componentes de material impreso 

La conexión de componentes implica la instalación de líneas de cobre en material 
impreso entre conectores de componentes. Las conexiones eléctricas entre dos o más 
terminales de conexión se denominan red de señal eléctrica. Nos esforzamos por una 
red de señal eléctrica más corta porque las líneas más largas causan efectos parasitarios 
más serios. Las líneas deben romperse en un ángulo de 45 °, o podemos usar líneas 
redondeadas. Las líneas de cobre están conectadas en el centro de las almohadillas de 
conexión, para lo cual utilizamos la red en funcionamiento o la función "ajustar al 
objeto", que depende del programa. La conexión entre dos puntos puede consistir en 
una sola línea. Para corrientes más altas es necesario usar VIA más grandes, que 
disminuyen la impedancia y aumentan la confiabilidad. Entre las almohadillas de 
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conexión en distancia 100mil, disminuimos el ancho de línea. Las líneas de suministro 
de energía y conexión a tierra deben ser más anchas para cargas de corriente más altas. 
Las líneas de suministro de energía y conexión a tierra deben establecerse lo más cerca 
posible, lo que puede ser bloqueado eficientemente por elementos de capacitancia. No 
debería haber "islas" de cobre sin conexiones. Estas islas deben estar conectadas a tierra 
o eliminadas. La Imagen 8 presenta diferentes formas de conectar elementos. 

 

                  a)                                                                         b)                                                    c) 

IMAGEN 8: CONEXIONES DE MATERIA IMPRESA A) APROPIADO, B) APROPIADO, C) NO APROPIADO. 

 

Elección de material impreso 

Al elegir los materiales para la materia impresa, tenemos diferentes posibilidades que 

difieren en varias características, tales como: seguridad contra incendios, estabilidad de 

temperatura, absorción de humedad. Estas características están definidas por la 

asociación internacional NEMA - National Electrical Manufacturers Association. La Tabla 

4 presenta una visión general de los materiales para la producción de material impreso.  
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Material  Comment 

FR-1 Bakelite: at room temperature poor moisture resistance. 
FR-2 Bakelite: suitable for single-layered PCBs, good moisture resistance. 
FR-3 Epoxy resins: a balanced material with good mechanical and 

electrical properties. 
FR-4 Glass fibers: excellent mechanical and electrical properties. 
FR-5 Glass fibers: high strength at high temperatures, self-extinguishing. 
G10 Woven glass and epoxy: high insulation resistance, maximum 

mechanical strength, high moisture resistance. 
G11 Woven glass and epoxy: resistant to bending at high temperatures, 

extreme solvent resistance. 
CEM-1 Cotton paper and epoxy. 
CEM-2 Cotton paper and epoxy. 
CEM-3 Non-woven and epoxy. 
CEM-4 Woven glass and epoxy. 
CEM-5 Woven glass and polyester. 
PTFE Pure - expensive, low dielectric loss, for high-frequency applications, 

very low moisture absorption (0.01%), mechanically soft. Difficult to 
laminate, rarely used in multilayer applications. 

RF-35 Fiberglass-reinforced ceramics-filled PTFE. Relatively less expensive, 
good mechanical properties, good high-frequency properties. 

Alumina Ceramic: Hard, brittle, very expensive, very high performance, good 
thermal conductivity. 

Polyimide A high-temperature polymer: Expensive, high-performance, higher 
water absorption (0.4%). Can be used for cryogenic temperatures to 
over 260 °C. 

TABLA 4: TIPOS DE MATERIALES PARA CIRCUITOS IMPRESOS. 

La etiqueta FR significa material ignífugo. El espesor del recubrimiento de cobre 
en la materia impresa es por estándares de 0.5oz (18 μm), 1oz (35 μm) o 2oz (70 μm). 
También hay otras normas que se utilizan con menos frecuencia (12 μm) y (105 μm). Las 
materias impresas con núcleo de aluminio o metal tienen un recubrimiento de cobre de 
incluso 70μm a 400μm. El material más utilizado en entornos industriales es FR-4. Este 
material es la elección óptima en cuanto a precio y calidad. 

Al diseñar material impreso, también elegimos varias capas. El alto número de 
capas generalmente aumenta los costos de producción, pero también permite la 
producción de materiales impresos más pequeños y resistentes. 

• Tablero impreso a una cara: Es adecuado para circuitos sencillos de baja 
frecuencia, como se ve en la imagen 9. El circuito se puede producir con 
muchos puentes. Dichos circuitos tienen una peor resistencia a las 
perturbaciones electromagnéticas. El diseño de circuitos complejos en 
una PCB de una capa requiere mucho más esfuerzo e innovación. Por lo 
general, se usan para dispositivos piloto y pruebas tempranas de 
componentes. 

• Tablero impreso a dos caras: A menudo están hechos de material FR-4, 
como se ve en la imagen 10. El circuito es más fácil de conectar. Si es 
posible, la superficie inferior está destinada a la conexión a tierra, y otras 
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conexiones quedan en la superficie superior. Las ventajas de la superficie 
de puesta a tierra son una mayor estabilidad mecánica de la materia 
impresa y una menor impedancia de todas las conexiones a tierra (reduce 
el ruido). Agrega capacitancia distribuida a cada conexión en la capa 
superior, lo que ayuda a prevenir las perturbaciones electromagnéticas. 
Actúa como un escudo contra el ruido electromagnético, cuya fuente 
puede ser material impreso..  

• Materia impresa multi cara: Puede haber 4, 6, 8, 10 o hasta 38 capas 
utilizadas. Estos son más adecuados para dispositivos sensibles de alta 
frecuencia. El grosor habitual de la impresión impresa a 2 caras es de 1,5 
mm, que es demasiado. A una distancia menor entre la capa superior e 
inferior, logramos una mejor capacitancia distribuida. También es más 
fácil conectar la fuente de alimentación y las conexiones a tierra (fuente 
de alimentación y capas de conexión a tierra). La conexión se realiza 
fácilmente a través de VIAs. Otras líneas de señal tienen mucho espacio 
en todas las otras capas, lo que simplifica significativamente la conexión. 
Mayor distribución de capacitancia entre la fuente de alimentación y las 
capas de conexión a tierra que disminuye el ruido de alta frecuencia. 
También bloquea mejor las perturbaciones EMI / RFI. La producción de 
materiales impresos multicapa es significativamente más costosa en 
comparación con los circuitos con menos capas.

 

IMAGEN 9: MATERIA IMPRESA A UNA CARA. 
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IMAGEN 10: MATERIA IMPRESA A DOS CARAS. 

 

IMAGEN 11: MATERIA IMPRESA MULTI-CAPA. 

 

11.3. Ejemplos de uso del programa Altium Designer 
 

El programa Altium-Designer es un entorno profesional para el diseño de circuitos 
impresos en todas las fases, que son: 

• Diseño de diagramas de flujo y diagramas de bloques. 

• Diseño de placas de circuito impreso-PCB. 

• Diseño de software para FPGA (Field Programmable Gate Array). 

• Soluciones de sistema para FPGA y depuración (cuando se trabaja con 
placas de desarrollo adecuadas, como Altium NanoBoard). 

• Diseño de sistemas incorporados. 

• Herramientas de simulación para circuitos digitales y analógicos. 

• Análisis de calidad de señal. 

• Gestión de procesos de producción de PCB. 
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Altium incluye editores e interfaces de programas para todos los pasos del diseño 
de dispositivos electrónicos. La escritura y edición del código del programa junto con la 
traducción se realiza dentro del entorno Altium Designer. En nuestro caso, prestaremos 
más atención al dibujo y diseño de la placa de circuito impreso para un dispositivo 
electrónico. El contenido está diseñado de una manera que ofrece una visión general de 
las diferentes fases de diseño de PCB. La primera fase de diseño incluye un esquema del 
esquema eléctrico. La segunda fase incluye la traducción del esquema en circuito 
impreso. En esta fase, determinamos las dimensiones de la materia impresa, la 
disposición de los elementos y las conexiones. En la tercera fase, mostraremos cómo 
presentar el material impreso en un entorno 3D y las posibilidades de usarlo en otros 
programas CAD. Para este caso, veremos el circuito generador actual, que se ve en la 
imagen 12. 

 

IMAGEN 12: ESQUEMA DE CIRCUITO GENERADOR. 

 

11.3.1 Creando un nuevo proyecto 

Para cada nuevo material impreso, se recomienda crear un nuevo proyecto 
porque en un proyecto hemos guardado todos los documentos y configuraciones 
relacionados con el proceso de diseño. El archivo de proyecto xxx.PrjPCB es un archivo 
ASCII en el que se escriben todos los documentos y configuraciones de salida, como 
configuraciones de impresión y CAM. Los documentos que no están relacionados con el 
proyecto se llaman documentos gratuitos (free documents). También agregamos 
enlaces a esquemas eléctricos, PCB, FPGA, VHDL incorporado (lenguaje de descripción 
de hardware Verilog) y bibliotecas. Cuando se completa el proyecto, todos los diseños 
se sincronizan dentro de los documentos en el proyecto. El proyecto se crea con el 
siguiente conjunto de comandos: 

• Elegir  File → New → Project → PCB Project, imagen 13. 
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IMAGEN 13: CREANDO UN PROYECTO NUEVO. 

• Podemos ver window Projects, donde se lista el proyecto 
PCB_Projects.PrjPcb sin documentos adjuntos. 

• Renombrar el proyecto, en nuestro caso a Current_ generator.PrjPcb, así 
que se pueda guardar en la carpeta que deseemos con los siguientes 
comandos: File → Save Project As → Current_generator.PrjPcb. 

 

Entonces crear un nuevo archive para el diseño del esquema eléctrico 'schematic'. 
Crear un nuevo esquema:  

• Elegir File → New → Schematic. Podemos ver archivo Sheet1.SchDoc  que 
se añade automáticamente al Proyecto que se había creado previamente,  
imagen 14.  

• Renombrar el esquema a Current_generator.SchDoc. Guardar el esquema, 
File →  Save As → Current_generator.SchDoc. 
 

 

IMAGEN 14: CREAR ESQUEMA DE CIRCUITO. 
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Cuando se abre un esquema vacío, podemos ver una vista completamente 

modificada con diferentes teclas, menús, etc. Ahora estamos en el editor de esquemas 

eléctricos. Si queremos agregar el esquema ya esbozado de otro proyecto al esquema 

creado, entonces elija Add Existing to Project. 

Antes de comenzar a diseñar el esquema eléctrico, debemos establecer lo siguiente: 

• Formato de ajuste para la hoja de trabajo: Design → Document, Opción– elegir 

formato A4. 

• la hoja de trabajo se puede ampliar con una combinación de tecla CTRL + rueda 

de desplazamiento (scroll wheel); la vista también se puede ajustar a pantalla 

completa con el comando View → Fit Document [shortcut: V, D]. 

• Hay muchas configuraciones a las que se puede acceder desde el menú Tools → 

Schematic Preferences [shortcut: T, P], donde la configuración influirá en todos 

los esquemas en el proyecto de trabajo 

• Haga clic en el esquema y seleccione Default Primitives y habilite la opción 

Permanent, que ofrece valores preestablecidos básicos cuando seleccionamos 

un elemento eléctrico de la biblioteca y no las configuraciones que configuramos 

en el paso anterior.  

El diseño del esquema comienza con la elección de un elemento, visto en la 

imagen 12. En la biblioteca de elementos, buscamos todos los elementos, comenzando 

con el amplificador operacional MCP602. Altium tiene un soporte muy fuerte para 

bibliotecas de componentes eléctricos, como esquemas, enchufes y modelos 3D. Estas 

bibliotecas aún no están instaladas, pero podemos descargarlas de forma gratuita desde 

el sitio web de Altium (https://designcontent.live.altium.com/) si tenemos una licencia 

válida. También podemos descargar bibliotecas de libre acceso desde 2004 y ampliar la 

carpeta donde ya hemos instalado la biblioteca básica de Altium. 

Para buscar el amplificador correcto MCP602, pulsa Libraries y entonces Search 

(o pulsaTools → Find Components) y entonces se abre la ventana de dialogo Libraries 

Search.  

Debemos tener cuidado de que tengamos todos los componentes seleccionados 

y de que busquemos en Libraries on path donde tenemos que haber escrito la ruta 

correcta para las bibliotecas instaladas. Para una mayor posibilidad de resultados al 

buscar, no introduzca todos los signos, sino solo los principales, ya que diferentes 

fabricantes tienen diferentes prefijos y sufijos. Para hacer esto, introduzca la cadena de 

búsqueda entre dos asteriscos (en nuestro caso: * 602 *). Si elegimos un componente 

de la lista que aún no está instalado, entonces tenemos la opción de confirmar que 

podemos instalarlo inmediatamente y que luego se puede ejecutar. Para MCP602 

necesitamos instalar previamente la biblioteca por el fabricante Microchip (Microchip 
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Linear Devices.IntLib), y entonces MCP602 estará disponible, por lo que podemos 

seleccionarlo como se ve en la imagen 15. 

   

 

Para insertar, haga doble clic en el componente que permite mover el elemento 

al área de trabajo con el cursor. Antes de moverlo a un lugar determinado, podemos 

editar etiquetas y propiedades que se pueden habilitar presionando la tecla de 

tabulación. Luego en el campo Designator ingrese una etiqueta de componente que 

veremos en el esquema (en nuestro caso: U1A). En la verificación del modelo, si el 

componente tiene una toma correcta (en nuestro caso: conectores SMD SOIC - 8). 

Cuando hemos establecido todo lo necesario, podemos comenzar insertando 

componentes en el esquema. El componente se puede establecer en la posición deseada 

haciendo clic o presionando ENTER. Luego mueva el cursor y vea que con el siguiente 

clic podemos insertar otro OPA desde el cual la etiqueta U1A se incrementa 

automáticamente a U1B, y otras propiedades preestablecidas permanecen sin cambios. 

El entorno Altium permite múltiples inserciones de componentes del mismo tipo que se 

revocan con la tecla ESC. 

En el siguiente paso, insertaremos 7 resistencias. Para insertar, usaremos una 

biblioteca básica que está instalada en el entorno Altium bajo el nombre Miscellaneous 

Devices.IntLib. Escriba * Res * en el motor de búsqueda y luego seleccione la resistencia 

con el conector SMD tipo 2010 que está etiquetado como Res3. Seleccione el valor 25k 

que es el valor más común y luego puede cambiarse en ciertas resistencias. Restablezca 

Designator al valor más bajo R1 y comience con la introducción de valores, como se vio 

en el ejemplo anterior. A continuación, cambie el nombre de dos resistencias a Rref y 

Rb haciendo clic en cada una por separado y cambie el nombre en el campo Designator, 

como se ve en la imagen 16. 

IMAGEN 15: ELIGIENDO MCP602 DE LA BIBLIOTECA. 
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IMAGEN 16: ELIGIENDO RESISTENCIAS DE LA BIBLIOTECA. 

  Hacer lo mismo con los elementos estabilizadores de voltaje LM336 (2.5V, 

housing TO92) en la biblioteca ST-Electronics 'Power Mgt Voltage Reference.IntLib', 

capacitores (búsqueda string *Cap*) y conectores terminales (búsqueda string 

*Header*) que se puede encontrar en la biblioteca Miscellaneous Devices.IntLib, que 

se ve en la imagen 17. 

 

 

IMAGEN 17: ELIGIENDO LM336, CAPACITORES Y CONEXIONES TERMINALES. 

 

A continuación, organice los componentes correctamente en el esquema teniendo 
en cuenta la regla de entradas a la izquierda y las salidas a la derecha. Debemos tener 
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cuidado de que haya espacio suficiente entre los componentes para las conexiones, 
porque si conectamos la conexión eléctrica a través de los pines de conexión, el 
programa la conectará automáticamente con el conector cruzado, imagen 18.  

 

IMAGEN 18: DISPOSICIÓN DE ELEMENTOS 

 

A estos components temenos que añadir también potenciales de voltaje, como 

puesta a tierra cero  y suministro de corriente . Para fines de prueba, insertaremos 
GND y la fuente de alimentación Vdd (insértelos en varios lugares para retener una 
mejor visibilidad del esquema). Al conectar componentes, debemos considerar las 
siguientes reglas: 

• Necesitamos tener una buena vision del esquema en su totalidad. 

• Dibuja conexiones con la herramienta  Place Wire [shortcut: P,W]. 
Pon atención a las interconexiones para evitar cortocircuitos. 

• Si queremos mover los componentes después de que los hayamos 
conectado, debemos eliminar las conexiones actuales, mover los 
componentes y luego volver a conectarlos. También podemos usar la 
combinación de movimientos CTRL + con el ratón, lo que permite mover 
los componentes junto con conexiones hechas previamente. 

El diagrama de cableado terminado se puede ver en la imagen 19.  
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IMAGEN 19: ESQUEMA DE GENERADOR DE CORRIENTE. 

También necesitamos añadir al esquema los nombres de las conexiones 
individuales (redes y etiquetas de red) que luego pueden usarse en material impreso. 
Los nombres de conexión no son esenciales para el funcionamiento del circuito, sino que 
sirven como notas o referencias cuando se revisa el circuito finalizado o para 
reparaciones posteriores. Los conectores de componentes están conectados con redes. 
Algunas conexiones con mayor importancia y potencial en el esquema eléctrico se 
pueden nombrar con el nombre de nuestra elección. Al usar símbolos para GND y Vdd, 
hemos establecido automáticamente dos nombres. Al elegir Menu → Place → Net label 
[shortcut: P, N] tenemos la opción de establecer el nombre de cualquier conexión. Al 
presionar TAB, podemos cambiar la configuración, como el color, la disposición y el tipo 
de fuente para la etiqueta de la red antes de definir a qué conexión vamos a establecer 
el nuevo nombre, como se ve en la imagen 20. 

 

IMAGEN 20: VENTANA PARA ESTABLECER NOMBRE DE CONEXIÓN, TIPO DE FUENTE, COLOR, TAMAÑO, ETC. 
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En nuestro circuito utilizaremos nombre de conexión para voltaje de referencia 

Vref como se muestra en la imagen 21.  

 

 

IMAGEN 21: NOMBRE DEFINIDO PARA CONEXIÓN VREF . 

Con esto, hemos terminado de dibujar y diseñar el esquema eléctrico, que es la 

base para avanzar en el diseño de la placa de circuito impreso. Antes de comenzar a 

traducir el esquema a material impreso, se recomienda configurar los ajustes del 

proyecto. Esto incluye configuraciones para detectar errores, matriz de conexión, 

generador de clases, configuraciones para el comparador, generación de mensajes de 

advertencia, configuraciones para imprimir, etc. Altium usa todas estas configuraciones 

al traducir un proyecto. Cuando se traduce el proyecto, se verifican las reglas de diseño 

y eléctricas completas que se establecieron. Después de que se resuelven todos los 

errores, el esquema se traduce de nuevo y se carga en el proyecto de destino con, por 

ejemplo, documento PCB. El comparador de proyectos permite buscar las diferencias 

entre los archivos de origen y de destino que vemos y puede ser confirmado o rechazado 

(sincronizado) desde ambas direcciones. Todos los ajustes están disponibles en el menú 

Project → Project options.  

11.3.2 Determinar el material impreso  

Después de que el diagrama de cableado haya finalizado y la configuración sea 
correcta, podemos comenzar a traducir el esquema de cableado a material impreso. En 
la fase de transacción, todas las reglas de diseño de esquema electrónico se verifican 
con el posible seguimiento de errores y la opción de reparación. Para traducir el 
proyecto dado Current_generator.PrjPcb, debemos elegir Project → Compile PCB 
project. Cuando finaliza la traducción, el mensaje del traductor se ve en la ventana del 
mensaje. Para acceder a esta ventana, debemos ir a View → Workspace Panels → 
System → Messages. Los documentos traducidos se registrarán en la ventana View → 
Workspace Panels → Design Compiler → Navigator, donde podemos supervisar la 
estructura del documento, la lista de componentes y los tipos de conexión (al hacer clic 
en la conexión también podemos verla con líneas marcadas en el esquema). En caso de 
errores y una traducción incorrecta, estos eventos se registran en la ventana Error 
Messages. Si la traducción es exitosa, podemos pasar a un nuevo documento en el que 
podamos diseñar material impreso con el esquema eléctrico dado. Primero, creamos 
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PCB vacía. La forma más fácil es utilizar la interfaz PCB Board Wizard con la que podemos 
elegir entre formatos industriales estandarizados o dimensiones propias. Más tarde, 
estas configuraciones se pueden cambiar. PCB Board Wizard se puede encontrar en el 
menú Files, que debe estar habilitado para ser visible, como se ve en la imagen 22. Si la 
opción de archivo no está habilitada, entonces tenemos una fila de accesos directos a 
cierta función en la parte inferior derecha del esquema, y en la pestaña System, 
podemos marcar Files. 

 

IMAGEN 22: ELEGIR ACCESO DIRECTO A ARCHIVOS. 

La preparación del documento sigue los siguientes pasos: 

1. Primero pulse PCB Board Wizard y en la segunda ventana selecciones unidades 

métricas Metric, imagen 23. 

 

IMAGEN 23: WIZARD PARA CREAR PCB.  

2. En la tercera ventale elige entre formatos PCB. Podem os elegir Custom y 

entonces introducir las dimensiones W=40 mm, H=30 mm. Para la designación 

de borde de PCB, seleccione el tipo de línea Mechanical Layer1. 
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3. En las siguientes dos ventanas elija el número de capas y tipo de VIAs que 

entrarán en el grosor del PCB.  

4. Luego, seleccione qué tipo de componente instalaremos principalmente en PCB 

(SMD, PDIP, etc., dependiendo del socket) y en cuántos lados. La mayoría de los 

componentes están montados en la superficie y están instalados solo en un lado. 

5. En la siguiente ventana, seleccione la configuración recomendada para 

conexiones y VIAs: 

a) El grosor más pequeño de conexión = 0,25 mm 

b) La anchura más pequeña VIA = 1 mm 

c) El diámetro más pequeño VIA = 0,6 mm 

d) La distancia más pequeña entre conexiones = 0,25 mm 

La imagen 24 presenta dos ventanas de asistente para configuraciones de material 

impreso. 
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IMAGEN 24: PASOS 2 A 5 DE MATERIA IMPRESA. 

 

Después de la creación exitosa de material impreso, vemos una ventana con 
dimensiones seleccionadas. Para no tener fondo de página en blanco, elimínelo en la 
configuración haciendo clic en Design → Board options → Display sheet. La vista de 
PCB se puede ajustar con el comando View → Fit panel o acceso directo [V, F], visto en 
la imagen 25. 

 

a)                                                                                            b) 

IMAGEN 25: VISTA AJUSTADA DE MATERIA IMPRESA A) CON FONDO, B) SIN FONDO. 

Las dimensiones de PCB pueden cambiarse más tarde. La forma más fácil es dibujar 
la forma de marco deseada que se puede usar para determinar los bordes de PCB. Esto 
se puede hacer haciendo clic en todas las líneas que definen los bordes de la PCB con el 
ratón y luego seleccionar la función desde el menú Design → Board Shape → Define 
from selected objects, para recortar la PCB a la forma deseada, imagen 26. 
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IMAGEN 26: FORMA PCB PERSONALIZADA. 

 

11.3.3 Traducción de proyectos – Compilación 

Primero entra en el entorno del esquema eléctrico y traduce Design → Update 
PCB. Haga clic en Validate Changes, donde se verifica la probabilidad de error. Si todo 
es correcto, habrá marcas de confirmación en estado. Si los cambios no son correctos, 
debemos regresar, verificar los mensajes de error y resolver los errores. Cuando la 
comprobación de errores se realiza correctamente, haga clic en Execute Changes, que 
transfiere componentes y conexiones a PCB en el proyecto, imagen 27. 

 

IMAGEN 27: COMPROBACIÓN DEL ESQUEMA DURANTE LA COMPILACIÓN. 

 

Transferencia de componentes a la materia impresa PCB, imagen 28. 
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IMAGEN 28: FORMA DE ELEMENTOS PARA MATERIA IMPRESA. 

 

En la imagen 28 podemos ver que la disposición de los elementos en la materia 
impresa depende del diseñador. En este caso, es sensato considerar las pautas e 
instrucciones de un buen diseño de la materia impresa. En el siguiente paso se realiza la 
disposición de los componentes a la materia impresa. Los componentes se organizan 
haciendo clic en el componente y moviéndolo a la posición correcta (haga clic con el 
botón izquierdo y presiónelo mientras mueve el componente). Manténgase dentro de 
los límites de PCB. Con la barra espaciadora podemos rotar el componente mientras lo 
transfiere. El texto que está conectado a los componentes también se puede mover de 
la misma manera que los componentes. 

 

IMAGEN 29: COMPONENTES ARREGLADOS EN MATERIA IMPRESA. 

 

El entorno Altium tiene soporte de funciones para la fácil disposición de 
componentes. Varios componentes se pueden alinear horizontalmente, verticalmente, 
por diferentes bordes o línea central. También se pueden alinear con espaciado 
uniforme. Se puede acceder a estas funciones si seleccionamos el grupo de 
componentes, donde usamos la tecla MAYÚS o alrededor de los componentes que 
queremos seleccionar. Luego haga clic con el botón derecho del ratón y elija Align → 
Align [shortcut: A, A] y marcar las funciones deseadas en los ejes X e Y. Además, cuando 
seleccionamos uno o varios componentes, podemos moverlos con el ratón o usar la 
combinación de teclas: CTRL + MAYÚS y las teclas de flecha. Esto significa que una 
combinación de una tecla de flecha y CTRL causa un movimiento más pequeño 
(cuadrícula de captura x 1) en la dirección deseada que cuando presionamos las dos 
teclas CTRL + MAYÚS, lo que hace que los componentes se muevan para mayor distancia 
(cuadrícula de captura x 10). 
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La conexión de los elementos dispuestos se puede realizar de forma manual o 
automática. En la conexión manual, tenemos una mejor visión general de las conexiones 
y el trabajo lleva más tiempo. La conexión manual se usa con mayor frecuencia en 
asuntos impresos de mayor tamaño. La conexión automática es generalmente más útil 
en circuitos menos complejos. 

Conexión manual de material impreso PCB 

Conexión manual de PCB significa el establecimiento de conexiones y VIAs en 
material impreso para conectar todos los componentes según lo presentado por el 
esquema eléctrico. En el modo manual, generalmente diseñamos materias impresas 
más complejas, donde muchos aspectos de diseño son importantes, como la influencia 
de EMI, el diseño del circuito de RF, circuitos analógicos y digitales combinados, 
electrónica de potencia combinada y circuitos digitales / analógicos, etc. Muchas veces 
el diseñador tiene que decidir y tomar compromisos entre ciertas partes del diseño. 

En nuestro caso, haremos conexión manual, aunque el circuito es simple. 
Trataremos de dibujar la conexión de señal en la capa superior, para la capa inferior 
usaremos masa GND, a la que accederemos mediante VIAs y en ciertos casos con 
almohadillas de conexión (conectores P1 y P2 y referencia U3). Las conexiones consisten 
en segmentos secuenciales. En cada cambio comienza un nuevo segmento de conexión. 
En general, Altium permite la disposición de conexiones en disposición vertical y 
horizontal y en un ángulo de 45 ° (en configuraciones avanzadas también podemos usar 
curvas) para obtener un resultado final profesional. 

Utilizaremos la configuración estándar. Primero, elegiremos ver la Top layer. Use 
el shortcut L para acceder al menú View configuration, donde eliminamos la marca de 
verificación en la capa inferior y confirmamos el cambio, que se ve en la imagen 30. 

 

 

IMAGEN 30: ELECCIÓN DE LA MATERIA IMPRESA CAPA SUPERIOR. 

 

Conexión de inicio con  . Solo podemos conectar aquellos componentes o conectores 
que están interconectados eléctricamente en el esquema, que está en un entorno de 
PCB presentado por líneas rectas finas entre las almohadillas de conexión. Al presionar 
la tecla CTRL y hacer clic en cierta almohadilla de conexión, podemos verificar fácilmente 
qué almohadillas están interconectadas. Cuando creamos una conexión entre dos 
conectores, podemos terminarla con la función automática Auto-complete. Esto se 
puede hacer haciendo clic en el primer conector y luego en el segundo y durante eso 
presione CTRL y la tecla de flecha>. La conexión se creará de la manera más corta entre 
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ambos conectores. Esta función es exitosa si la ruta es bastante simple sin grandes 
obstáculos entre ambos puntos. La segunda forma es usar la tecla ENTER cuando las 
conexiones se terminan gradualmente, con lo cual disminuimos el número de 
segmentos en una conexión. Altium habilita otras formas de conexión manual donde 
podemos presionar MAYÚS + R durante el movimiento y seleccionar entre diferentes 
métodos: 

• Push: en este modo, la conexión intentará irrumpir en el otro punto al mover 
conexiones y VIA ya establecidos dentro de las reglas. 

• Walkaround: la ruta al segundo punto está tratando de encontrar trazando la 
conexión alrededor de los obstáculos sin mover las conexiones y VIAs existentes. 

• Hug & Push: esta forma es una combinación de las anteriores. 

• Ignore: este método permite establecer conexiones en cualquier lugar sin 
romper las reglas. 
 

También debemos ser conscientes de los componentes que establecemos en la 
superficie superior, donde también están las conexiones de señal y aquellos que tienen 
conexiones conectadas a través de PCB al otro lado. Dichos componentes están soldados 
a continuación, por lo que debemos conectarlos con conexiones de señal en la parte 

superior con VIAs. Los VIA se pueden encontrar con la tecla Place via . Debido a que 
utilizaremos la capa inferior para la masa, los VIA se instalarán en los conectores P1, P2 
y la referencia. 

Además de los componentes y VIAs, también es bueno predecir cómo se conectará la 
PCB a la carcasa, ya que generalmente necesitamos agujeros para los tornillos. Esos se 

pueden crear seleccionando Place Pad . No lo conecte a ninguna conexión eléctrica. 
Marque la opción Plated, por lo que no habrá mensajes de error más adelante cuando 
se verifique la PCB. 

Ahora necesitamos llenar el lado inferior de la materia impresa con la masa GND. Esto 

se puede lograr haciendo clic en el botón  Place Polygon Plane en la caja de 
herramientas, establecer sus características y luego definir los límites del polígono 
dibujándolos en PCB, como se ve en las imágenes 32 y 33. 
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IMAGEN 31: DETERMINACIÓN DEL POLÍGONO PARA LA MASA EN LA PARTE INFERIOR DE LA MATERIA IMPRESA. 

 

IMAGEN 32: MATERIA IMPRESA CON MASA AGREGADA GND EN EL LADO INFERIOR  

Enrutamiento automático 

Los PCBs más simples y menos complejos se pueden conectar con un régimen 
automatizado donde se cumplen estrictamente todas las reglas. En nuestro caso, 
queremos que una línea de señal en el lado inferior y el lado inferior de la PCB se 
reserven para el polígono GND. Para esto, tenemos que ajustar la configuración, por lo 
que las conexiones estarán solo en la parte superior. Esto se puede hacer en “reglas”. 
Design → Rules y en Routing Layers habilitamos solo la Capa superior Top Layer, 
imagen 34. Luego, seleccione desde el menú Auto Route → All y haga clic en Route All. 
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IMAGEN 33: ELEGIR LA CAPA SUPERIOR PARA LA CONEXIÓN AUTOMÁTICA ENTRE COMPONENTES. 

 

IMAGEN 34: RESULTADO DE LA CONEXIÓN AUTOMÁTICA. 

A primera vista, el resultado es similar, pero los detalles que ingresamos 
manualmente hacen la diferencia. Hay bastantes errores que podemos pasar por alto 
en la materia impresa. Tampoco se considera que los componentes que están soldados 
en el lado inferior del contacto eléctrico solo en el lado inferior, por lo que deben 
conectarse con conexiones con VIA en el lado superior. Los VIA son bienvenidos en las 
conexiones GND porque podemos acortarlos. Si nos conectamos automáticamente, es 
sensato usar grupos de conexión Net classes. Estos se pueden establecer a través de la 
interfaz de usuario Design → Classes. Aquí podemos agregar grupos yendo a la pestaña 
Clases de red y haciendo clic con el botón derecho, elegir Add class. Podemos ver una 
ventana donde están escritas todas las conexiones eléctricas disponibles en la columna 
Non-members ya la derecha hay espacio donde podemos agregar conexiones deseadas 
/ marcadas con un clic en la flecha. 
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IMAGEN 35: AGREGAR GRUPOS DE CONEXIÓN. 

Vista 3D  

La vista 3D permite que podamos ver PCB en el espacio desde todas las 

perspectivas. Podemos cambiar entre las vistas 1, 2 y 3. El número 3 es un atajo para la 

vista 3D, que se ve en la imagen 37. 

 

IMAGEN 36: VISTA 3D DE MATERIA IMPRESA. 

 

En la vista 3D se pueden usar los siguientes “atajos”:  

• Zoom: CTRL + scroll del ratón 

• Mover hacia arriba / abajo: rueda del ratón, mover hacia la izquierda / derecha: 

MAYÚS + scroll del ratón 

• Rotación: MAYÚS + tecla derecha en el mouse y arrastre en la dirección 

deseada que se puede seleccionar en la esfera con flechas. 

Altium permite la importación de objetos 3D desde diferentes herramientas CAD 

en formato * .step *. También es posible exportar en formatos, tales como: step, dwg / 

dxf. Los objetos exportados se pueden usar en otros programas CAD que admiten 

formatos mencionados. 
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Documentación final. 

La documentación final o de exportación se puede dividir en 5 grupos: 

1. Lista de partes 

a. Planes para la disposición automática de componentes robóticos.  

b. Planes para poner componentes en ambas partes del PCB.  

2. Documentación de salida 

a. Planes de componentes que incluyen conexiones de cobre. 

b. Vistas 3D de PCB. 

c. Representación esquemática de circuitos electrónicos 

3. Documentación para la producción de materia impresa 

a. Planos de taladrado compuestos: planes para orificios, su posición y 
tamaño, todo en un solo plano. 

b. Guías / dibujo de taladro: planifica los orificios y las instrucciones para 
hacer, su posición y tamaño en dibujos separados. 

c. Impresiones finales de las ilustraciones: en un plan, hay una gran 
cantidad de información de salida diferente. 

d. Archivos de Gerber: archivos de Gerber, hechos para cada capa de PCB 
por separado. 

e. NC Drill Files - para control numérico (CNC) de máquinas de 
perforación. 

f. ODB ++ - Creando bases de datos para el fabricante en formato ODB 
++, socketd en C ++. 

g. Impresiones del plano de potencia: planos para capas internas y 
separadas. 

h. Copias de máscara de soldadura / pegado: planes para capas 
protegidas. 

i. Informe de punto de prueba: informe sobre los puntos de prueba. 

 

4. Salidas – lista de conexiones 

a. Las listas presentan la lógica de conexión entre los componentes 

(en diferentes formatos de texto, CSV (valores separados por 

comas) 

5. Informes de salida 

a. Lista de materiales: lista de los materiales que necesitamos para la 
fabricación del circuito eléctrico. 

b. Informe de referencia cruzada de componentes: lista de componentes 
basada en el esquema eléctrico. 

c. Informar Jerarquía del proyecto: lista de todos los documentos. 

d. Informar redes de un solo PIN: lista de conexiones que tienen solo un 
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conector. 
Documentación para necesidades de producción 

En la última fase, antes de fabricar PCB debemos entregar todos los documentos 

necesarios al fabricante de PCB. Para esto, necesitamos enviar archivos de ejercicios de 

Gerber y NC y una lista de materiales. 

 

Almacenamiento de archivos Gerber: cada archivo Gerber corresponde a una capa 

física de material impreso con todos los perfiles de línea posibles (superposición de 

componentes, capas de señal, capas de enmascaramiento de soldadura, etc.). Antes de 

enviar y guardar archivos Gerber, se recomienda consultar al fabricante para que se 

unifique con sus requisitos. 

 


